
How to Win Any Argument About A.I.
If people argue that machines will never be cleverer than humans, simply ask them if they can program 
their VCR.



WFTPD Contents    (version 1.95, 10/18/94)

WFTPD - The Windows FTP Daemon

Quick Setup - how to start quickly
Common Questions - what people keep asking me.

How To:
Fix what broke in the quick setup
Work with Log files and screen logging
Secure your system
Register the program or contact the author
Play the Flute
Win Most Arguments About Artificial Intelligence

Menus:
Use the File Menu to deal with log files.
Use the Edit Menu for nothing much, yet!
Use the View Menu to turn off or on the status bar.
Use the Logging Menu to control what information is saved to the log, or on screen
Use the Messages Menu to give messages to users on connection, logout and change of directories.
Use the Security Menu to limit the number of users, who can log in, and where they may log in from.

Command Line Options:
Run invisibly with the 'h' option

Miscellaneous:
Upload Announcement
Changes made in version 1.95
Changes made in version 1.9 (and minor version changes)
Look for these features soon...
Acknowledgements
About The Author



Quick Setup
The important part of a quick setup is to note what WFTPD has as its defaults:

No Log File
Greedy Option off
No logging to screen or disk
A blank Greeting and Farewell message
No display of the MESSAGE.FTP file on a CD command
User/password security enabled - no users defined
Anonymous user disabled, and restricted to the C:\ directory and beneath, should you re-enable this user.
Host/Net security allows all hosts/networks to access WFTPD
No limit on the maximum number of simultaneous users.

This means that what you will need to do on first starting up WFTPD is either to enable the Anonymous 
user, or add users and passwords, or a combination of both.    Or, if you don't need password protection, 
simply disable user/password security and allow anyone access to your system.



The Log File
The Log File is a simple text file with the following format:
[X nnnn] mm/dd/yy hh:mm:ss <Message text>
X is a single character, one of:

L - login
C - command
G - get (RETR)
P - put (STOR/STOU)
A - anonymous login
? - Debug information

nnnn is a four digit hex number for the connection number that this message applies to - connections are 
numbered from 0001 from the time the program is started.    When the program is exited and restarted, 
the count restarts at 0001.

mm/dd/yy is the date, and hh:mm:ss is the time of the message being written to the log file.

This same information is written to the screen.

You can select the types of messages that will be listed through the Logging menu options.



Greedy Option
The greedy option has been disabled in this release, since it no longer has any impact on the 
inner workings of this program.    This topic is to be ignored, and will disappear in the next version 
of the help file - it is here for old users to note that it has been removed.

There are two schools of thought regarding reading data from an external host through winsock - one 
says to read as much as you can, as often as you can, and the other says to read a set amount each 
time, and to allow a little more time to other Windows applications.    The Greedy option controls the 
choice of these two methods.    When this option is ticked, you may notice your Windows system 
performance degrades when people are storing files on your system.    If it is not ticked, people storing 
files on your    machine will lose a certain amount of network performance.

Since it's a matter of personal choice as to which is more important, I've left this as a simple menu option, 
under the File Menu.

Many people are asking for a Greedy Option for sending data - I'm considering implementing this at some 
point, and it shall be done with timers, if I ever work out how to make them work.



Greeting And Farewell Messages
These messages are currently a maximum of 20 lines long, and are entered through a very simple multi-
line edit control.    Any text can be entered here, although it would be advisable to limit yourself to only 
those characters that are most prevalent amongst the internet community - i.e. 7-bit ASCII.

The Greeting message is displayed to each new connection before they get the prompt for the user 
name, and the Farewell message is displayed after the FTP daemon receives a QUIT command from the 
client.    In addition, I add one line to each of these messages as a kind of 'promotion', to remind users 
who wrote the marvelous server that they are connected to.

The default messages are blank in the registered version.    In the unregistered version, you cannot edit 
these messages, and they bear messages enticing your users to tease you about being unable to 
scrounge up $15 for a registration fee.    If you feel these messages are a problem, please read this.



The MESSAGE.FTP File
When this option is ticked in the Messages menu, any time a user changes directory, the new directory is 
checked for a file called MESSAGE.FTP. If this file exists, it is printed as part of the success message 
informing the user of his change of directory.

This file may be as long as you can type, but bear in mind that many people have twenty odd lines of 
screen and no scrollback - if it can't fit on one screenful, you stand the chance that it will not be read in its 
entirety.

This feature was inspired by wuarchive's facility to display a .message file on certain commands.

You may want to make the MESSAGE.FTP file hidden (use the DOS command "ATTRIB +H 
MESSAGE.FTP", or select MESSAGE.FTP in the File Manager, then choose the "Properties" option 
under the "File" menu, and check the "Hidden" box), so that users do not try to delete it, or change its 
contents - this is especially important since directory rights have not been written yet.



The User/Password Security Dialog
This dialog allows you to grant different users access to different parts of your disk(s), and in a future 
version will allow you to grant different kinds of access to different users.

The Close button simply exits the dialog

The Add/Update button updates the WFTPD.INI file with the information displayed in the edit boxes.    This 
button is grayed if the two password entries (the password and the Verify boxes) are not filled in exactly 
equal.

The Delete button removes a user's entries from the WFTPD.INI file.

Clicking the down arrow to the right of the box for the user name will produce a list of user names already 
in the WFTPD.INI file.    The    parameters for this user will only appear once the focus is moved away 
from the user name box.

The Password/Verify boxes will always display '*' for each character entered. This is a standard protection 
scheme to ensure that people in the next town with high-powered binoculars can't log in to your prized 
system.

The passwords are stored in encrypted fashion on the WFTPD.INI file.    If you wish to retain your 
password from a UNIX system, you may copy the password entry from the /etc/passwd file into the 
WFTPD.INI file - e.g. if my /etc/passwd entry is:
alun:hajibabaomars:194:958:Alun Jones:/home/home/on/the/range:/bin/bash

I would put an entry in the [passwd] section of the WFTPD.INI file a line that reads:
alun=hajibabaomars

The "Home Directory" is the directory that the user first sees when he logs in.

If you check the option "Restrict to Home", the user will not be able to change directory to any directory 
that does not contain the home directory as a substring, effectively limiting his access to his home 
directory and below.

The "Enable security" and "Allow Anonymous" check boxes, which were on this dialog in previous 
versions, have been moved to the General Security dialog.

Remember that everywhere throughout WFTPD, the username "ftp" is synonymous for "anonymous".    (A 
little alliterate)



Host/Net Security
Preliminary reports suggest this feature may not be working in this release.

This dialog allows you to deny or allow access to your site based on the internet address of the host 
trying to connect.    There is a pair of radio buttons indicating what the default action is - whether you want 
to generally deny all incoming connections, or whether you wish to allow all connections by default.

Underneath these buttons is a box labeled "Specific action", which contains a list box labeled "Host 
address".    Any hosts listed in this box (and you can type extra hosts in) may be changed from the default 
action.    Please note that to add or change a host's entry, you MUST click on the Add/Update button.    To 
remove an entry, simply select it in the list, and click on the Delete button.

The Host Address must be a numerical IP address - four numbers from 0 to 255 separated from one 
another by dots (the "." character).    To specify several hosts in a range, remember that a "*" represents 
the range 0-255.

If your default action is to allow all hosts, then only those addresses set to "deny" will take any action, and 
vice-versa.    If your default action is the same as the specific action for a particular host, then it makes 
sense that that action is what occurs!

The Close button will exit this dialog box - it will not in itself save any alterations that you have made to 
the host tables - this is done only through the Add/Update and Delete buttons.

I have not had a chance to run this option through as much testing as I would have liked, so it 
may still be a little flakey.



The Security Menu

This menu contains four options that allow you to tailor the security of your site.    Only the top three are 
currently enabled - the fourth will come into effect in a later version of WFTPD.

The three active options are:

General - for miscellaneous settings
User/Password - to add users, edit their passwords, and set home (login) directories
Host/Net - to accept or deny connections based on what machine they come from



The Message Menu
This menu contains three options.    The Greeting and Farewell messages allow you to design messages 
that are printed when a user logs in or out, respectively.    The MESSAGE.FTP option is a checked option, 
that, when enabled, allows a message to be printed out which changes for each directory the connecting 
user enters.



The Logging Menu
This menu has the following options:

Logging On - turns logging to screen and log file (if opened) on.
Clear Screen - clears the log on screen.

Gets - starts/stops logging all Get (RETR) commands
Puts - starts/stops logging all Put (STOR/STOU) commands
Logins - starts/stops logging all successful user logins
Anonymous - starts/stops logging all successful anonymous logins
Commands - starts/stops logging of all ftp commands received.

Winsock Calls - this option is only to be used for debugging purposes - many of the items reported are of 
little consequence, and despite some bizarre numbers appearing when this option is enabled, most are 
simply status reports.    If this is enabled, it may cause WFTPD to use more memory, to slow down, and 
maybe even to appear to hang.    It is not recommended unless you are trying to solve a problem in 
conjunction with the author, Alun Jones.



The View Menu
Currently this menu only enables you to turn on or off the status bar. The status bar has one purpose, and 
that is to give you a brief description of each menu option you might select.



The Edit Menu
In some later version of the software, this will allow you to copy sections of the screen log into the 
clipboard, for pasting into other programs.



The File Menu
This contains commands to open or close the current Log File, and the exit command.

Previous versions also contained the option to enable/disable the Greedy Option, but this feature has 
been removed due to its obsolescence.



How To Play The Flute
Well, basically, Jackie, you blow in one end, and move your hands up and down it.

Next week we'll be teaching you how to rid the world of all known diseases and how to make black and 
white people live in harmony.



How To Secure the system
Currently, since there is no concept of user rights, it is not possible to allow a user to only download, or 
only upload.    This means that you have to be careful that one user does not ruin it for the rest.    WFTPD 
is not a totally secure ftp server.

This is probably best achieved by providing each user with a separate directory, and restricting them to 
that directory and below.    All this can be achieved through the User/Password Security dialog.

If users persist in being naughty, you can deny them access to your machine through use of the Host/Net 
Security dialog.



How To Work with Log Files and Screen Logging.
When you first fire up WFTPD, no log file will be defined, and all logging will be disabled.    You will 
probably want to use a Log File, so that you can find out what happened during your unattended hours, 
and so that you can have a record of what is going on in your system.

To create a log file, simply open it from the File Menu's Open Log option.    From now until you close the 
file, all log messages will be stored into this file.    If you close the software, it will re-open this file when it 
is restarted.

Logging to the screen is automatically enabled whenever logging is on. This is selected from the Logging 
Menu.    Through this menu, you can also select what actions are logged, and you can also clear the log 
on screen.



How To Fix What Broke in the Quick Setup
I'm not sure what you mean - nothing broke in the quick setup.
Maybe you should email me at "alun@neosoft.com"



New and Innovative Uses for WFTPD
The following uses have been reported to me:

As a standard FTP daemon - this is obvious.

A print server - put a file into LPT1, and it goes out the port! (Actually, I seem to have broken this in the 
latest revisions - oops!)

For remote system administration - simply install it with the 'h' option, and run it on all of your systems - 
this allows you to update software, and retrieve configuration files for local editing, allowing you to 
remotely administer windows machines anywhere on your network.

As a poor man's WWW server - place your html files in a directory that the 'anonymous' user can get to, 
using the extension ".htm", and point people to the URL "file://yoursite.domain/yourdirectory/yourfile.htm" - 
this is new to version 1.95



The 'h' Option
If you run WFTPD with a command line argument of 'h' or 'H', then the program will run without an icon, 
and will not show up in the task switcher.    This means that WFTPD cannot be closed without exiting 
windows, and its options cannot be altered.    This is probably only useful for remote system 
administration, where (to quote an existing user) "you don't want bozos deciding they know how to rewire 
their systems".



Upload Announcement
WFTPD195.ZIP        Windows FTP daemon 1.95 for Winsock 1.1

Uploaded by the author (ideally).

WFTPD - the all round useful Windows FTP Daemon.

WFTPD has the following useful features:

o Support for the majority of FTP commands (it doesn't support the obscure ones for mail, etc.)
o Multiple logins and simultaneous transfers allowed
o Works with Mosaic (new!)
o Runs over most Winsock drivers (some people have reported occasional problems with PC-NFS 
Winsock, but this is usually fixed by updating to the current version of PC-NFS)
o Fast - I get 120-500K per second on average over 8 bit ethernet
o Secured access by means of password authentication, address-based host authentication, and the 
ability to restrict users to named subtrees of your directory structure
o Remote access to ALL drives on your system is possible
o Windows friendly - does not flash cursors while it is transferring, or hold up processing
o Can run 'invisible' - with no user access to the program
o Easy configuration of user/password lists, security features, logging to file.    All features adjustable 
through menus - no need to edit clumsy INI files.
o Logs logins, anonymous logins, gets, puts, commands - what's logged is configurable
o Logs to file that can be read by other applications, including session number, time and date stamp.    
This information is also logged to the screen.
o Small - 190K
o Cute little icon

In addition, for the low price of $15, you get these features:

o Easily configurable greeting - the unregistered one tells people that you can't afford $15
o As many transfers per login as required - only 5 are allowed in the unregistered version before you have 
to re-login.    (Directory listings don't count towards this 5)
o Greater say in future features
o Peace of mind - can you sleep at nights knowing that your $15 may be the only thing standing between 
me and an overdraft?



Changes Introduced in Version 1.9
(Minor version changes are at the bottom of this page)
The following features have been moved in this version:

o File|Security dialog is now under Security|User/Password
o Logging|Logfile dialog is now under File|Open Log
o File|Greeting dialog is now under Messages|Greeting

New items on the menu include:

o File|Close log - stops logging transactions to file, but carries on logging to screen.
o The Messages menu now contains Greeting (formerly under File), Farewell (for the logout message) 
and MESSAGE.FTP - when this toggle is turned on, any CWD operation will look for the file 
MESSAGE.FTP in the new directory, and if it exists, will display it to the user.
o The Security menu now contains User/Password (formerly File|Security), Host/Net (for restricting which 
hosts may log in to your server), and Rights (for assigning each user a different set of rights in each 
directory. Rights will be activated when I write the code to do it, probably in version 2.0.
o On-screen logging is now supported - this has been the most requested feature since the FTP daemon 
was first released!    Since my internet connection is often flaky, I figured I'd cut down on my incoming mail 
and actually put the feature in!
o RMD will not accept a parameter with ':', '\' or '/' in it - this way you have to CWD to a directory's parent 
in order to delete it.    This may seem cumbersome, but is a valuable security feature.    MKD has a similar 
restriction.
o CDUP and XCUP are supported, as is STOU, SYST, REIN.
o The title bar will display the log file when it is opened from the .INI file.
o If the backlog of stuff to send is bigger than the socket buffer, it's now expanded continually, and 
eventually when the information gets sent the buffer will reduce.    It'll do this in steps of 4K.
o I am still finding it difficult to open a file sharable by other processes, so the log file is still locked.

Minor version changes
1.9a - fixed a bug in the asynchronous message handling for trumpet users.
1.9b - fixed a really bad security bug that allowed unprotected access.
1.9c - fixed a tiny bug in the directory listing, that made it list times wrongly.    Also made the help file 
prettier!
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What is FTP?
FTP is the Internet standard File Transfer Protocol.    The WFTPD program attempts to provide the most 
useful and most often used elements of the daemon (server) side of this protocol, as described in RFC # 
959.



What is a daemon?
A Daemon, also referred to as a server, is a program which will run in the background carrying out certain 
tasks while the main work of the processor carries on in the foreground.    The daemon is connected to by 
a client program, usually on a different computer.
The term derives from a word meaning a 'helpful servant', and unlike "demon", has no intrinsic connection 
to either good or evil.    The word is pronounced "day-mon".



Look at the How To Register section in this file.    Please be sure to use the order forms provided in this 
section.



Generally I ask for $500 for each 100 users.    This does not include the cost of source code. If you want 
to buy source code, please send me email.



Firstly, you lose the limit on the number of files that can be transferred in a single session.    You can also 
modify the greeting and farewell messages.    If you have sent me an Internet-reachable e-mail address, 
you will be added to a mailing list, and kept informed of all new versions.    On the more esoteric side, you 
get a good feeling, and you encourage me to work on new versions and fix bugs.



Registered users are entitled to free updates whenever they are made, although there is a charge 
imposed for delivery through regular mail.    Usually this is $5 - $1 for the disk mailer, ~$1 for the disk and 
label, $1 for postage inside the US, $2 for external postage.    The rest is for handling.    The unregistered 
shareware version should always be available from ftp.cica.indiana.edu in directory /pub/win3/winsock.    I 
also try to put the file onto oak.oakland.edu, ftp.demon.co.uk and sunsite.unc.edu - all standard winsock 
sites.    Oh, and I shouldn't forget Adam Glick's useful winsock site, b61563.student.cwru.edu (you may 
even recognise the server when you log in!).



You've fetched down the winsock.dll file from ftp.ftp.com, which only works alongside the full TCP/IP 
package produced by FTP Software, called PC/TCP.    This winsock is NOT free - either find one that is, or 
buy one of the commercial stacks that support winsock programs.    Heaven knows - maybe you could 
even buy FTP Software's PC/TCP!



You are using an old version of PC-NFS.    I believe that this is a problem with version 5.0, but it certainly 
is a problem with previous versions.    Please contact your dealer, and get the new version.



If you are using FTP Software's PC/TCP, this is something they are working on (as of 5/24/94), but they 
are extremely close to getting a good working version, so I hear.    You might want to check the ftp site 
ftp.ftp.com to see if a new version of winsock.dll is there that fixes your problem.    Note that this 
winsock.dll will only work with FTP Software's PC/TCP stack.



Not necessarily - it's entirely possible, since the winsock specification is so new, it's likely that there may 
be some parts of the spec that I read in a different way from the people who developed your winsock 
stack.    Winsock developers are working hard to make their stacks work with the most frequent of the 
disagreements, and I am also ready to change my program to work wherever it turns out I have a 
misconception.

If you think there may be a problem with your winsock stack, please email me, or technical support for the 
manufacturers of your stack.



This is a common misconception - my program is designed to work with any winsock stack that 
implements version 1.1 of the winsock specification (version 2.0 of the specification is just entering its 
design phase).    Most winsock stacks on the market implement version 1.1 of the spec, but to differentiate 
between different versions of their own stack, they give different version numbers to each copy of the 
stack.    Hence, PC-NFS is at version 5.1, PC/TCP is at version 2.31, and Trumpet Winsock is at version 
1.0 rev. A (or 1.0 B beta 6).    All of these stacks implement an interface that is compatible with version 1.1 
of the winsock specification.



Not likely, in the general case - I've made sales of the source code to a couple of companies, and it's a 
little unfair on these people if I offer the code free to anyone else, or if I sell it for significantly less.



Two small points here - first, the unregistered version is generally designed for testing, before you 
register.    I'd feel very embarrassed if I was using an unregistered version of shareware to deal with 
customers, especially the influential ones - what kind of impression does it give to your customers when 
they find you are using them as a test case?    The second point is that you probably spent enough time 
complaining to me that you've already cost yourself (or your company) at least $15.
As another interesting point, I've had many people tell me that they registered specifically because they 
found the message amusing.
The message stays!



The main purpose for the next version is the implementation of per-user protections on directories.    Also, 
Look Here!



Well, this is a tough one.    The company I work for, and who provide me with enough money to keep me 
alive and reasonably stocked with gadgets, has recently undertaken a mammoth development task.    As 
one of their main programmers, I've got a lot of work on my plate right now, so I don't know when I'll be 
able to start work on version 2.0.



My email address recently changed from "alun@wst.com" to "alun@neosoft.com" since I no longer work 
for Welcom Software Technology.



I use the Trumpet winsock at home - this can be fetched from many public ftp sites.    It costs $20 to 
register, and seems to be pretty robust.    The canonical site is ftp.trumpet.com.au, but it is very difficult to 
log onto, because of its high traffic.
At work, I used the Microsoft VxD TCP/IP stack, which is available for free from the ftp site 
ftp.microsoft.com - it used to be in directory /peropsys/wfw/tcpip/vxdbeta, but has since moved.    This is a 
fairly solid stack, and promises to be the basis of TCP/IP support in future versions of Windows.    
Currently, this VxD stack works only on Windows for Workgroups 3.11.
Also available is the PC/TCP stack, from FTP Software, PC-NFS from Sun, Chameleon from NetManage, 
and several others.    Check in computer magazines for more details - look under network software.    If the 
advert doesn't explicitly say that it's winsock compliant, call the company before buying it.    WFTPD will 
only work on winsock compliant stacks.



Frequently Asked Questions

Select the question you would like to ask, and the answer should pop up.

Q. How Do I Register?

Q. What Does Registration Get Me?

Q. Why did your email address change in this version?

Q. How do I get a new version of WFTPD?Q. Why is WFTPD 'crippleware'?

Q. What do you offer in the way of site licences?

Q. When I run your program, a dialog says I am missing PCTCPAPI.DLL - why?

Q. My server only allows one connection, before I have to restart it - why?

Q. Why can I only transfer about the first 32k of all files, or not transfer anything at all?

Q. Is my winsock stack faulty, since it won't work with your software?

Q. You say you require winsock version 1.1 compliance, but my stack is version 1.0.    Where can I 
get the updated version?

Q. I'm interested in learning winsock programming - can I get a copy of your source code?

Q. What's going to be in the next version?

Q. When are you going to ship the next version?

Q. What winsock stacks do you know of that I might fetch?
Q. Why do you have such a rude message in the unregistered version?    ("My customers don't 
appreciate seeing this when they log in, and some of them are very influential people!")



Look for these features soon...
Please note that none of these features have yet been written or designed, and some of them may not yet 
make it into wftpd.    Please tell me which features you'd like to see.

(The ordering is most definitely not indicative of preference)

Suggested Features:

o Access limited at various times to different numbers of users
o Configurable message for too many users.
o Put all messages in text strings in resource information (to allow easy adjustment)
o Adjustable time-out on inactive connections.
o Individual user rights on directories
o Tidy up on-screen log handling - perhaps allow access to the full log file?
o Try to work out sharable file writing.
o View Current connection status (using a button?).
o MESSAGE.FTP's name should be changable, and it should not be PUTtable.

Bugs (or misfeatures) to (try and) fix:

None known yet!



The "Rude" Greeting Message

The message that we are talking about, in case you forget, is:

This copy of WFTPD is NOT REGISTERED

This means that the institution, company or individual that you
are connected to is unable or unwilling to send $15 to the author
of this program.

To register this program, or receive new details on it, send email
to alun@neosoft.com (Alun Jones), or snail-mail to Alun Jones,
1910 Westmead #3702, Houston TX 77077 USA

The only complaint I treat as valid is the complaint that you have not yet had time to send me the money, 
or that I have not yet responded to your registration.

The basic point is that WFTPD is NOT free software - it is shareware, which means you are welcome to 
distribute the unregistered version, and you are welcome to try the unregistered version out to see if the 
registered version is likely to fulfill your needs.    I would hope that you are either not likely to test 
unregistered shareware on any business clients, or that you keep them fully informed that they are 
participating in a test of unregistered shareware.    I doubt that you will find any test clients that will protest 
at the simple message above.



What's new in this release

I think I've fixed the following problems:

o ABORting a transfer should work properly now.
o Leading spaces are not stripped from messages stored in the INI file
o MESSAGE.FTP is now displayed on all logins.
o "GET *.EXE" (NOT MGET) no longer produces "Internal Application Error".
o The scrollbar always shows up, even if WFTPD is started minimised.
o Memory leaks on closing WFTPD should be (mostly) fixed.
o Memory hogging is reduced, and logging is much improved, because I stopped fighting the system!

I also enabled these new options:

o Use the port address in the services file (if present), otherwise default to 21.
o PASV mode support (for Mosaic).
o Fetching files with full path names while maintaining security (for Mosaic).
o The Security options "Enable Security" and "Allow Anonymous" have moved to underneath the 
"Security ; General" dialog from the "Security ; User Security" dialog.
o The "Security ; General" dialog has an option to limit the number of users that can connect.    (Setting 
the limit to 0 makes it unlimited.    If you want to disable logins, simply close the ftp daemon!)
o All "Add/Alter" buttons now read "Update" so novice users can understand.
o I have tightened up the "PUT" functionality, so that hopefully it'll cause fewer problems.
o Directories don't show up any more in NLST results - only regular files.
o LIST and NLST results are now sorted before being output.
o LIST commands can no longer list directories you don't have access to (part one of beefier security)
o If users are added with no password, they get placed properly into the [passwd] section.

I have completely written the networking subsystem, so PUTting has sped up, and the greedy option now 
has no effect.    GET commands no longer tie up the machine, either!

This version seems to work well with Beta 14 and above of the Trumpet Winsock - Peter Tattam has fixed 
some messaging problems that were causing me trouble.



About the author

Alun Jones is an English programmer, who married an American PC specialist in October 1994.    He's 
very pleased that there have been some site licences that allowed him to get married and go on 
honeymoon without going too deeply into debt.

Alun appreciates all user feedback, and is smart enough to know that if he can fix a bug, it'll help him 
make more money because it's easier to sell a good program.    What he doesn't appreciate is people who 
complain about his program (especially in public forums), without first checking with him as to whether he 
might have already fixed the problem.    This is especially annoying when the bug referred to was fixed 
several months before - you have been warned!    :-)

What Alun really hates is Barney - the bloated purple styrofoam dinosaur.    Kids should be encouraged to 
imagine, yes, but they should lead their own imagining, not have it led by some overweight Jurassic 
remnant with an apparent IQ lower than the average speed limit in this country. 



General Security Dialog

The General Security dialog is accessible from the Security menu, and has three items of interest, 
besides the usual OK and Cancel buttons:

"Enable Security" - when checked, wftpd will ensure that nobody logs in without entering a valid user 
name, and its associated password.    If not checked, users may log in with any name and password 
whatsoever.

"Enable Anonymous" - Anonymous ftp is the term for logging in to an ftp daemon as "anonymous", or 
"ftp", at which point you are asked to enter your email address as your password.    Hence, anyone can 
log in to your machine when this option is checked - they do not need to know a password, but they will 
be restricted by your choices in the User/Password Security dialog.

"Maximum number of users" - this is the largest number of users that may be logged into your server at 
any one time.    Each user requires one socket for his command and output connection, and each time 
they transfer a file, or do a directory listing, they will take up another socket for the duration of that 
transfer/listing.    By restricting the number of users that log in, you will make sure that your machine runs 
smoothly (it has less to do!), and that users will not face messages telling them that they cannot transfer a 
file because of a network error, when there are several users on at once.

Entering 0 as the maximum number of users sets the ftp server to accepting any and all incoming 
connections.



Registration Information

Order forms must accompany all registrations.    There are three different methods of receiving your 
software, with their own accompanying order forms, which can be found below.    If I receive a cheque or a 
purchase order without an order form, it can sit for quite some time before I am able to call you or your 
purchasing department, in order to get all the information I need.

Payment may be made either in U.S. dollars, or in pounds sterling (i.e. English money).    All cheques 
should be made out to "Alun Jones" - note the spelling - I am not named after any chimpunks, so don't try 
and make any cheques out to "Alvin" - you only make me mad. :-)

The price for this software is either US $15, or G.B. £15.    Add 5 (dollars or pounds) if you want me to 
send you a disk with the software - if your delivery method is FTP or Email, delivery is free, as are 
upgrades.

The cost in pounds is slightly more expensive, but usually cheaper than getting a money order, 
apparently.    Please, if neither of these is your currency, make sure that your purchasing department 
knows the price of the software is based on one of these two currencies - occasionally, the value seems 
to have been converted to and fro in the purchasing process, and I end up with less money because of it!

Software is sent through your suggested delivery method soon after receiving either a cheque, cash, 
money order (for US dollars or English pounds), or a purchase order.    If you use a purchase order, make 
sure it clearly states that the order is for "WFTPD - Windows FTP Daemon" - I am not sufficiently trusting 
to assume that an order for "General Lab Supplies" covers my software.

The regular mail address for sending order forms, payments or purchase orders is:

Alun Jones
1910 Westmead #3702
Houston TX 77077
USA

Or, if it is any easier:

Alun Jones (WFTPD)
47 Sugden Road
Long Ditton
Surrey
KT7 0AD
UK

Order forms and purchase orders can also be faxed to me at (+1) (713) 531 8428.    E-mail 
correspondence for comments and suggestions should be sent to "alun@neosoft.com".    Note this is a 
change from my previous e-mail address.    (Why?    Click here)

It often helps me if you can tell me how you use the software - I have found some New and Innovative 
Uses for an FTP daemon out there.    This will allow me to determine whether all the features of the 
software are useful, or whether they need to be rewritten.

Click here for pricing on site licences.

The order forms are separately listed for:
Delivery by email or ftp
Delivery by 'regular' mail - this costs $5 or £5 extra, and frequently takes me longer to arrange.



Order Form for Delivery by FTP or Email

Alun Jones
1910 West Mead #3702
Houston, TX 77077

Name: _______________________________________________

Company Name:    _______________________________________________

Address:    _______________________________________________

_______________________________________________

Phone Number:    _______________________________________________

Delivery Method:                               E-Mail                                FTP                  (mark at least 

one)

E-mail Address:    _______________________________________________
(If not Internet, please specify.)

(For FTP delivery, the following three entries are all required - I will not deliver wftpd to an 
anonymous account under any circumstances.    Please remember to be careful about upper/lower 
case distinctions)

FTP Site: _______________________________________________

FTP User Name: _______________________________________________

FTP Password: _______________________________________________

QTY Price Each Total

$15.00
Payment may also be made in pounds sterling, in which 
case I use an exchange rate of one dollar to one pound.

Send this order form along with your check to:    Alun Jones, 1910 West Mead, #3702, 
Houston, TX 77077, USA.

Please contact Alun Jones at the above address or e-mail alun@neosoft.com for site 
licenses, comments or suggestions.

As this software is shareware, there is no warranty implied or otherwise, nor is support provided.    
However, if you discover any bugs or problems please contact the developer at the above e-mail address.



Order Form for Delivery by 'Regular' Mail

Alun Jones
1910 West Mead #3702
Houston, TX 77077

Name: _______________________________________________

Company Name:    _______________________________________________

Address:    _______________________________________________

_______________________________________________

Phone Number:    _______________________________________________

(The E-mail address is required if you wish to be kept informed of new versions.)

E-mail Address:    _______________________________________________
(If not Internet, please specify.)

QTY Price Each Total

$20.00
Payment may also be made in pounds sterling, in which 
case I use an exchange rate of one dollar to one pound.

Send this order form along with your check to:    Alun Jones, 1910 West Mead, #3702, 
Houston, TX 77077, USA.    Upgrades cost $5 and can be requested from the same 
address.

Please contact Alun Jones at the above address or e-mail alun@neosoft.com for site 
licenses, comments or suggestions.

As this software is shareware, there is no warranty implied or otherwise, nor is support provided.    
However, if you discover any bugs or problems please contact the developer at the above e-mail address.



Many people use the term 'crippleware' to refer to software that is restricted in some way in its 
unregistered form, and some people feel that 'crippleware' should not be encouraged.    I also feel that this 
should be unnecessary, and the first few versions were not restricted in any way.    The first few versions 
also got only two or three registrations.    As an experiment, I decided to restrict the next version a little, 
and suddenly all sorts of places started to register.

My point here is that if I had not restricted the software, I would have received so few registrations that 
there would not be a WFTPD program.    One of my other previous programs (HP2PS, an HPGL to 
PostScript translator) was free, but asked people to donate a fair amount to me - it received precisely no 
money, and I have not produced a new version for over a year, and do not intend to.




